• Purchasing Policy & Procedures
• Navigating Banner 9
• How to Process a Purchase Requisition
• How to Attach Backup Documents to a Purchase Requisition

Jan 2020
## Table of Contents

Section 1.0  Purchasing Policy – When should I use a purchase requisition?  Pg. 3

Section 2.0  How do I navigate Banner 9?  Pg. 6

Section 3.0  How do I process a purchase requisition in Banner 9?  Pg. 10
   3.1  Requestor/Delivery Information Section  Pg. 12
   3.2  Vendor Information Section  Pg. 13
   3.3  Commodity/Accounting Section  Pg. 16
   3.4  Balancing/Completion Section  Pg. 20

Section 4.0  How do I add my backup documentation to my requisition?  Pg. 23
   4.1  Attaching Backup Documentation  Pg. 24

Appendix 1  Direct Payment Vouchers (List)  Pg. 29
Appendix 2  Quick Reference Guide (Purchase REQ – Step by Step)  Pg. 30
Please Note:

Manuals

Purchasing policies and procedures should be followed in conjunction with ALL State of Texas statutes, policies and procedures.

Additional policy & procedures include, but are not limited to Midwestern State University Policy & Procedures, Midwestern State University Fiscal Policy & Procedures, Midwestern State University Purchasing Manual and the Midwestern State University Procurement Card Guide. These manuals can be found on the MSU Purchasing homepage.
What is a purchase requisition?

A purchase requisition is an internal document used to “request” the purchase of goods or services by the Purchasing Department. It documents the following:

- Who placed the order (end-user & department)
- The name of the vendor
- What you are wanting to order
- How you plan on paying for your order

The purchase requisition also documents the electronic approval by supervisors or those responsible for a department’s budget.

When should I use a purchase requisition to purchase goods & services?

- When a Direct Payment Voucher (DPV) cannot be used (See Appendix 1).
- When a potential purchase will exceed your prescribed procurement card single purchase limit.
- When a vendor will not accept the University procurement card.
- When University policies & procedures require it.
- PRIOR to placing an order intended for a purchase order

While preliminary discussions with a vendor (by the end-user) are acceptable, the official purchase order and commitment of funds for the University is completed by the Purchasing Department. The end-user has no authority to make a commitment before submitting a requisition and obtaining an authorized purchase order number. In addition, the end-user must allow an adequate amount of time for the Purchasing Department to complete the purchasing process, depending on the type of purchase being made (i.e., developing specifications, soliciting formal bids, requiring on-site visits, HUB Subcontracting Plan, etc.).

Exemptions from Bidding or Price Comparisons

The University defines the following additional exemptions from the above bidding or price comparison process:

- Advertising
- Hotels and Conference Rooms
- Conference Expense; expenses related to conference room services such as audio/visual/network and food services. (Does not include goods purchased for attendees or transportation services.)
- Moving Expenses (employee)
- Student Travel; expenses related to student travel
- Library materials for Midwestern State University Library, when such exemption represents the best value to the University
- Membership Fees and Dues
- Newspaper and magazine subscriptions, books, videos and software direct from the publisher
- Freight
• Intra-Agency Payments
• Rental of exhibit space; i.e., booths for display purposes
• Goods and services provided by the Texas Department of Criminal Justice (TDCJ)
• Internal Repairs
• Purchases from Federal Agencies
• Utilities
• Goods and Services for an organized activity when such exemption represents the best value to the University

Proprietary Product/Sole Source Purchases

Proprietary Source purchasing represents the purchase of a specific item that is available from only one vendor who is the sole manufacturer and/or only distributor of the item. The end user must submit a justification explaining the need for the item and why only this specific item/vendor will meet the department's needs. See Sole Source Justification Form.

Historically Underutilized Businesses (HUBs)

Historically underutilized businesses or HUB vendors are defined as Texas businesses that are at least 51% owned, operated and controlled by United States citizens, born or naturalized and members of qualifying groups which include Asian Pacific Americans, Black Americans, Hispanic Americans, Native Americans and American Women.

All state agencies and institutions of higher education are required to make a good faith effort to increase businesses with HUBs. This good faith effort applies to all funds and all dollar amounts, including amounts that do not require bidding (including procurement card purchases). Departments must attempt to use HUBs when placing orders under delegated authority.

The Comptroller's Statewide Procurement Division offers the following directory to assist in finding HUB vendors:

https://mycpa.cpa.state.tx.us/tpasscmblsearch/index.jsp

![Image 1.01 – Statewide Procurement Division Hub Directory Search](image-url)
You can search for vendors by Vendor ID and Vendor Name. You can also filter your search by commodity category or location. The Purchasing Department is available to assist when searching for HUB vendors.

Unauthorized Purchases

An unauthorized purchase is any purchase made in a manner other than the Purchasing Tools described above. **Entering a requisition after the order has been placed violates University policy.** Unauthorized purchases present problems and create unnecessary paperwork for the Purchasing Department, Accounts Payable, vendors, end-users and supervisors. Pre-planning is the best way to avoid an unauthorized purchase.
How do I navigate Banner 9?

Database “Forms” are sometimes referred to as “data entry screens” and are used to control how end-users interact with the data contained in a database (i.e., Banner Finance System). Forms can be used to protect data and to ensure the data is entered properly or can be used to query your database data for a particular output.

When logging into Banner 9, you will navigate to a specific form using the “Search” box. To prepare a purchase requisition you will type “FPAREQN” in the “Search” box to go directly to that form.

Image 2.01 “Search” Box @ Main Menu

The following is a list of a few frequently used Banner Finance Forms you may find yourself navigating:

<table>
<thead>
<tr>
<th>Banner Form</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>FPAREQN</td>
<td>Create Purchase Requisition</td>
</tr>
<tr>
<td>FPIREQN</td>
<td>Query (View) Completed Purchase Requisitions</td>
</tr>
<tr>
<td>FROIDCH</td>
<td>Document History (View document status &amp; all related banner documents)</td>
</tr>
<tr>
<td>FGIITRND</td>
<td>Detail Transaction Activity (by Fund)</td>
</tr>
<tr>
<td>FGIENCD</td>
<td>Detail Emcumbrance Activity (by Document)</td>
</tr>
<tr>
<td>FGBAVL</td>
<td>Budget Availiablity Status</td>
</tr>
<tr>
<td>FGIBDST</td>
<td>Organization Budget Status</td>
</tr>
<tr>
<td>FOAAINP</td>
<td>Document Approval (Approval Future)</td>
</tr>
<tr>
<td>FOIAPPH</td>
<td>Document Approval History (Approval Past)</td>
</tr>
<tr>
<td>FOADOCU</td>
<td>Document by User</td>
</tr>
<tr>
<td>FOAUAPP</td>
<td>User Approval (All documents needing approval)</td>
</tr>
<tr>
<td>FPIOPOV</td>
<td>Purchase Orders by Vendor</td>
</tr>
</tbody>
</table>
When exiting a specific form use the “Exit” icon in the form tool bar.

![Image 2.02 Exiting a Form](image)

If you’ve navigated specific forms in your current session of Banner 9, you can find your previously visited forms by clicking on the “Recently Opened” tab at the main menu.

![Image 2.03 “Recently Opened” Tab @ Main Menu](image)

When navigating fields within a form, Banner will offer helpful hints in the “Help Bar” located just below the form fields.

![Image 2.04 Banner 9 Help Bar](image)
The “Related” menu can also be a source for additional information depending on the form you are currently using. Banner 8 users will identify the “related” menu with the “Options” menu.

![Image 2.05 Banner 9 Related Menu](image)

![Image 2.06 Banner Quick Reference Guide](image)
### Navigating Banner Quick Reference Guide

<table>
<thead>
<tr>
<th>Function</th>
<th>Key stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Shift + Z</td>
</tr>
<tr>
<td>Cancel action</td>
<td>Esc</td>
</tr>
<tr>
<td>Select on a Called page</td>
<td>Alt + S</td>
</tr>
<tr>
<td>Retrieve BDM Documents</td>
<td>Alt + R</td>
</tr>
<tr>
<td>Add BDM Documents</td>
<td>Alt + A</td>
</tr>
<tr>
<td>Submit Workflow</td>
<td>Alt + W</td>
</tr>
<tr>
<td>Release Workflow</td>
<td>Alt + Q</td>
</tr>
</tbody>
</table>
To process and complete a purchase requisition (with required backup documentation) for electronic approval, requisitions must be processed using Banner 9 in Google Chrome. “Click” on the “Banner 9” tab on the Information Technology page. Then “click” on the “Banner 9” hyperlink under Banner-Production Systems and log-in. Your Banner 9 login will be your computer login & password.
You will be directed to a page similar to the following:

Banner 9 allows for two page layouts: Expanded and Compacted. You can change between these two modes by using the “Tools” tab located at the right of the screen once you are in any form.
Please follow the steps listed below to start processing a purchase requisition in Banner 9:

**SECTION 3.1 Requestor/Delivery Information Section**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Banner Main Menu, enter <strong>FRAREQN</strong> into the &quot;Search&quot; box and press &quot;Enter&quot;</td>
</tr>
<tr>
<td>2</td>
<td>Click on the &quot;Go&quot; icon on the right side of the screen. <strong>DO NOT</strong> enter a requisition number or the text &quot;NEXT&quot; into this field.</td>
</tr>
<tr>
<td>3</td>
<td>Tab to &quot;Delivery Date&quot; field. <strong>DO NOT</strong> change &quot;Order Date&quot; or &quot;Transaction Date&quot; fields.</td>
</tr>
<tr>
<td>4</td>
<td>Click on the Calendar or manually enter the delivery date.</td>
</tr>
<tr>
<td>5a</td>
<td>If you have info for the &quot;Comments&quot; field (30 characters max) enter the data and press &quot;enter&quot;.</td>
</tr>
<tr>
<td>5b</td>
<td>Tab to the &quot;Requestor/Delivery/Information section if you don’t have data for this field.</td>
</tr>
</tbody>
</table>

**A. REQUESTOR/DELIVERY/INFORMATION SECTION**

Default information should populate most of the fields in this section.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Click on the &quot;Organization&quot; field and enter your home &quot;ORG&quot; code, then press &quot;enter&quot;.</td>
</tr>
<tr>
<td>7</td>
<td>Click the &quot;NEXT Section&quot; icon at the bottom left to go to the &quot;Vendor Information&quot; section or simply click on the tab using your mouse.</td>
</tr>
</tbody>
</table>

**NOTE: **DO NOT** change "Ship To" address information.** Orders purchased using the Purchase Requisition process must be delivered and received at Central Receiving.**
The following steps will help you process the Vendor Information Section of your INB purchase requisition:

**B. VENDOR INFORMATION SECTION**

**NOTE:** If the vendor is a company the University has not used before, their information may not be in the Banner Database.

- **8a** If the vendor is new, a completed & signed W9 is required to set them up. This will be attached as backup documentation to your REQ.

- **8b** If the vendor is new, simply type the vendor name in vendor name field and click "Next Section" to move to the "Commodity/Accounting" Section or simply click on the tab using your mouse.

- **8c** If this is an existing vendor in Banner click on the list button on the "Vendor" field.

Select "Entity Name/ID Search" (FTIIDEN).

To search for an existing vendor, tab to the "Last Name" field.
<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Using % as the wildcard character, enter the vendor's name and press the &quot;F8&quot; key or “Go” to execute the query. <strong>NOTE:</strong> Using the % symbol in the beginning of a query request (e.g., %Office) will return results similar to &quot;Texas General Land Office&quot;. Using the % symbol at the end of a query request (e.g., Office%) will return results similar to &quot;Office Depot&quot;. You can be specific or general with your search criteria depending on how you use your wildcard. Remember the Banner search feature can be toggled as case sensitive or case insensitive using the selectors. **</td>
</tr>
<tr>
<td>12</td>
<td>If you wish to redefine your search query &quot;click&quot; on the &quot;Exit&quot; icon and repeat steps 8c through 11.</td>
</tr>
</tbody>
</table>

**Image 3.23 Vendor Information (Vendor Query)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>13a</td>
<td>After locating your vendor &quot;Double Click&quot; on that vendor using your mouse.</td>
</tr>
<tr>
<td>13b</td>
<td>Clicking on the list button on either the &quot;Address Type&quot; or &quot;Sequence&quot; will provide a list of different addresses.</td>
</tr>
<tr>
<td>13c</td>
<td>Using the record bar below the entries, you can see the different addresses associated with that vendor.</td>
</tr>
<tr>
<td>13d</td>
<td>After locating your preferred address &quot;Double Click&quot; on the &quot;Address Type&quot; using your mouse. This will update your &quot;Vendor Information&quot; fields.</td>
</tr>
</tbody>
</table>
You can then tab down to the "Contact" or "Email" field to add additional contact information.

**NOTE: DO NOT add/adjust the "Discount" or "Currency" fields.**

To move to the "Commodity/Account" Section click on the "Next Section" icon or simply click on the tab using your mouse.
C. **COMMODITY/ACCOUNTING SECTION**

**NOTE:** Upon arriving in this section you will be assigned your purchase requisition number. Please write this number down as you will need it to attach your backup documentation.**

16 Add your backup documentation to your requisition at this time.

17 Tab to the "Description" field to enter the description of the first item to be purchased (50 character max).

The Commodity/Accounting section of the requisition will be where you will most likely add your backup documentation. This is because this section is where Banner assigns your requisition a requisition number. Instructions for adding your backup documentation appears in Section 4.0 of this manual.
If you are adding additional information for this line item, use your mouse and click on the "Related" tab in the top right of the menu bar and select "Item Text". On the next screen, hit the “Go” button at the right side. Multiple lines can be added (50 characters max per line) by using your mouse and clicking on the next field. Remember to save your item text to your requisition.

**NOTE:** Additional text information can also be added to the requisition itself by clicking on the "Options" tab in the top menu bar and selecting "Document Text". On the next screen, hit the “Go” button at the right side. Multiple lines can be added (50 characters max per line) by using your mouse and clicking on the next field. Remember to save your document text to your requisition.

To navigate back to the Commodity/Accounting section, use your mouse and click on the "X" in the top menu.
19  If you are not adding additional text to the specific line item, tab to the U/M (Unit of Measure) field.

20  Use the list button to get a list of valid "U/M" codes.

21  Enter the "Quantity" of line item (1) you wish to order, then tab to the "Unit Price" field.

22  Enter the "Unit Price" of line item (1) you wish to order, then tab through the "Extended, Discount & Additional" fields to end up back at the "Description" field.
<table>
<thead>
<tr>
<th><strong>NOTE:</strong> <strong>DO NOT</strong> enter amounts into the &quot;Discount&quot; or &quot;Additional&quot; fields. Note the discount for the items in the &quot;Item Text&quot; field for that particular line item, then reflect the discount in the adjusted &quot;Unit Price&quot;.**</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong> If you run out of visible &quot;Description&quot; fields you can use your mouse to click on the &quot;Insert&quot; tab in the menu bar to the right of the Commodity section. This will add another line for you to continue your entries. **</td>
</tr>
<tr>
<td>Using your mouse, move your cursor to the next &quot;Description&quot; field and repeat steps 17 through 22 as necessary.</td>
</tr>
<tr>
<td>When you are finished adding commodity information, click on &quot;Next Section&quot; to move the accounting portion of this section.</td>
</tr>
<tr>
<td>COA (Chart of Accounts) is always &quot;M&quot;.</td>
</tr>
<tr>
<td>Skip &quot;Index&quot; and enter your &quot;Fund&quot; and &quot;Org&quot; information into their respective fields. The &quot;Prog&quot; field will default populate. <strong>DO NOT</strong> change it.</td>
</tr>
<tr>
<td>Tab to the &quot;Acct&quot; field and enter <strong>7300</strong>. (This will be the Acct Code for all purchase requisitions).</td>
</tr>
<tr>
<td>Tab to the &quot;Extended Amount&quot; field and enter the amount you wish to be paid from this FOAPAL. You can pay from multiple FOAPAL's but your &quot;Document Accounting Total&quot; must match your &quot;Document Commodity Total&quot;.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Requisitions paying from HEAF &amp; Local Funds must be done on separate requisitions. Please note in the &quot;Comments&quot; field of the &quot;Requestor/Delivery Information&quot; section the corresponding REQ# for each requisition or &quot;1 of 2&quot;. Backup documentation should be attached to both requisitions.**</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If you run out of visible &quot;FOAPAL&quot; fields you can use your mouse to click on the &quot;Insert&quot; tab in the menu bar to the right of the Accounting section. This will add another line for you to continue your entries. **</td>
</tr>
<tr>
<td>To move to the &quot;Balancing/Completion&quot; section, click on the &quot;Next Section&quot; icon or simply click on the tab using your mouse.</td>
</tr>
</tbody>
</table>
3.4 Balancing/Completion Section

You can use the "Next/Previous Section" function to navigate back to the "Requestor/Delivery Information" section and double check for errors. You can also use your mouse to click on each tab to navigate through your requisition.

If you need to save your requisition you can click on the "In Process" icon at the bottom of this section. To reacquire your incomplete requisition, simply go to FPAREQN and enter your purchase requisition number.

If your requisition is complete and ready to move to the approval process, click on the "Complete" icon.
**NOTE:** If you need to retrieve a completed requisition you can "Deny Document" in "FOADOCU". This must be done prior to the approval and forwarding of the requisition to the Purchasing Department.**

**NOTE:** To check on the status of a requisition you can go to "FOAAINP" to see where your REQ is in the approval process.**

FOADOCU will also allow you to review a list and query documents you have processed.
If a requisition is not approved (REQ Denied), the original requisitioner will get a daily email with an attachment of the requisitions that have been denied along with the reason for the denial (if the approver gave one).

The original requisitioner will also receive a daily list of all requisitions that been approved.

To delete an incomplete requisition, go to the “Requestor/Delivery Information Section and select “Delete” from the menu bar. In the status bar at the top right of the requisition, you will be prompted to “Press Delete Record again to Delete this Record” to make this permanent.
To attach backup documentation to your requisition, you should at minimum, complete a purchase requisition in Banner 9 up to the "Commodity/Accounting Section" of your requisition. While you can add images to your requisition at any stage afterward, you at least need the "Document ID" (purchase requisition number) to tie your image to your Banner document.
It is ideal for you to attach your backup documents to your requisition prior to forwarding your requisition for approval. This allows all approvers to see any important backup documentation required to make an informed decision regarding the approval/denial of a requisition. Please convert ALL your backup documents prior to attachment to a PDF.

When creating your purchase requisition, the “Commodity/Accounting Section” is where you should get into the habit of adding your backup documentation. Here you will be assigned the requisition number necessary to attach your backup documents.

You can save your requisition by clicking on “In-Process” and attach additional documents at a later time, but if you are planning on completing your requisition from start to finish (with backup documents) the Commodity/Accounting Section is where you should access BDM.

Using your mouse click on the "Add" icon located in the top right of the screen.

After pushing the “Add” Button, Application Extender will open up in a separate Google Chrome tab with the above appearance. Rather than the old menu that had several drop downs to get where you need to add the document, it automatically comes up on the screen for you.
2. Click on the “Add Page” button of the Application Extender window.

3. Click on the “Choose Files” button from the window that opens. (Preferably in PDF format)
4 Select the file that you wish to upload to the requisition and then click the “Open” button.

***PLEASE NOTE THE DOCUMENT UPLOAD WILL BE EASIEST IF YOU PUT ALL OF THE PAGES IN THE SAME PDF FILE TO UPLOAD ALL AT ONCE. IF YOU SELECT MULTIPLE DOCUMENTS, THEY WILL ALL BE UPLOADED TO THE SAME DOCUMENT***

5 Once you have selected your document, click on the “Upload” button.
6 This will bring up your document. You will next need to click on the “Document Type” field.

7 Next, select “Requisition Backup” from the drop-down menu.
Then, click on the “Save” Button at the right side of the screen. This will upload ALL pages of the document you selected. If you have any other documents to upload, you will have to close this window and then go back through the same process to label and attach any other documents you wish to upload.

The Application Extender will show you the document you uploaded, including all pages of that document.
Appendix 1

Direct Payment Vouchers

The following have been identified as items that may be presented directly to the Business Office for payment using a Direct Payment Voucher (DPV).

a. Registration fees for conferences, seminars workshops (These can be paid using the University P-Card or processed on a DPV).
b. Umpire/Officials fees for officiating sporting events.
c. Memberships (These can be paid for using the University Procurement Card or processing a DPV).
d. Overnight hotel lodging (paid on behalf of an official University guest).
e. Fees for performers and entertainers (non-employees only).
f. Business meal reimbursements.
g. Fees for Guest Lecturers (non-employees only).
h. Subscriptions and Periodicals (unless a Purchase Order is required - may also be purchased using the University P-Card).
i. Filing fees for work to be performed on buildings (i.e., Texas Department of Health).
j. Professional registration/license fees (excluding software licenses).
k. Postmaster-Permit, bulk rate fees and meter charges.
l. Insurance premiums.
m. Bus charters (unless a Purchase Order number is required by the company).
n. Miscellaneous fees and assessments (i.e., accreditation, royalty, copyright and appraisals).
o. Fleet Vehicle Rentals (see attachment for FAQ’s).
p. Advertising

Contracted purchases such as Guest Lecturers or Performers & Entertainers must have a completed contract routing form and signed contract (per Contract Management Procedures) prior to being paid for on a DPV. DPV’s & Purchase Requisitions containing contract routing forms and contracts should be forwarded to the Contract Management Office prior to processing to ensure all documentation adheres to current Policy & Procedures.

Procurement Card, Purchase Requisitions & Purchase Orders

Items not found on the above list must be purchased using the University Procurement Card or Purchase Requisition process. These orders must be processed per MSU’s Purchasing Manual and Procurement Card Program Guide.

The University Procurement Card (P-Card) can be used to pay for small orders from vendors that accept MasterCard. Items that cannot be purchased using the P-Card or DPV must be processed using the Purchase Requisition process.

Completed Purchase Requisitions should be forwarded to the Purchasing Department. Orders using the Purchase Requisition process cannot be placed by the end-user, but should be ordered by the Purchasing Department via a completed Purchase Order.

Note: Any University employee who makes a contract for supplies, equipment and/or services without a purchase order from the purchasing office, he/she may be held personally responsible for clearing the account with the vendor.

- Questions regarding the use of the Direct Payment Voucher should be directed to Business Office (X4107).
- Questions regarding the use of the Procurement Card should be directed to the Purchasing Office (X4740).
- Questions regarding placing orders using the Purchase Requisition process should be directed to the Purchasing Office (X4111) or (X4095)
- Questions regarding Contract Management should be directed to (X4041) or (X4277)
## Appendix 2

### Quick Reference Guide – Purchase REQ (Step by step)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Banner Main Menu, enter <strong>FPAREQN</strong> into the &quot;Search&quot; box and press &quot;Enter&quot;.</td>
</tr>
<tr>
<td>2</td>
<td>Click on the &quot;Go&quot; icon on the right side of the screen. <strong>DO NOT</strong> enter a requisition number or the text &quot;NEXT&quot; into this field.</td>
</tr>
<tr>
<td>3</td>
<td>Tab to &quot;Delivery Date&quot; field. <strong>DO NOT</strong> change &quot;Order Date&quot; or &quot;Transaction Date&quot; fields.</td>
</tr>
<tr>
<td>4</td>
<td>Click on the Calendar or manually enter the delivery date.</td>
</tr>
<tr>
<td>5a</td>
<td>If you have info for the &quot;Comments&quot; field (30 characters max) enter the data and press &quot;enter&quot;.</td>
</tr>
<tr>
<td>5b</td>
<td>Tab to the &quot;Requestor/Delivery/Information section if you don't have data for this field.</td>
</tr>
<tr>
<td>A.</td>
<td><strong>REQUESTOR/DELIVERY/INFORMATION SECTION</strong></td>
</tr>
<tr>
<td></td>
<td>Default information should populate most of the fields in this section.</td>
</tr>
<tr>
<td>6</td>
<td>Click on the &quot;Organization&quot; field and enter your home &quot;Org&quot; code, then press &quot;enter&quot;.</td>
</tr>
<tr>
<td>7</td>
<td>Click the &quot;NEXT Section&quot; icon at the bottom left to go to the &quot;Vendor Information&quot; section or simply click on the tab using your mouse.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td><strong>DO NOT</strong> change &quot;Ship To&quot; address information. <strong>Orders purchased using the Purchase Requisition process must be delivered and received at Central Receiving.</strong></td>
</tr>
<tr>
<td>B.</td>
<td><strong>VENDOR INFORMATION SECTION</strong></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If the vendor is a company the University has not used before, their information may not be in the Banner Database. **</td>
</tr>
<tr>
<td>8a</td>
<td>If the vendor is new, a completed &amp; signed W9 is required to set them up. This will be attached as backup documentation to your REQ.</td>
</tr>
<tr>
<td>8b</td>
<td>If the vendor is new, simply type the vendor name in vendor name field and click &quot;Next Section&quot; to move to the &quot;Commodity/Accounting&quot; Section or simply click on the tab using your mouse.</td>
</tr>
<tr>
<td>8c</td>
<td>If this is an existing vendor in Banner, click on the list button on the &quot;Vendor&quot; field.</td>
</tr>
<tr>
<td>9</td>
<td>Select &quot;Entity Name/ID Search&quot; (FTIIDEN).</td>
</tr>
<tr>
<td>10</td>
<td>To search for an existing vendor, tab to the &quot;Last Name&quot; field.</td>
</tr>
<tr>
<td>11</td>
<td>Using % as the wildcard character, enter the vendor's name and press the &quot;F8&quot; key to execute the query.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Using the % symbol in the beginning of a query request (e.g., %Office) will return results similar to &quot;Texas General Land Office&quot;. Using the % symbol at the end of a query request (e.g., Office%) will return results similar to &quot;Office Depot&quot;. You can be specific or general with your search criteria depending on how you use your wildcard. <strong>Remember the Banner search feature can be toggled as case sensitive or case insensitive using the selectors.</strong></td>
</tr>
<tr>
<td>12</td>
<td>If you wish to redefine your search query, &quot;click&quot; on the &quot;Exit&quot; icon and repeat steps 8c through 11.</td>
</tr>
<tr>
<td>13a</td>
<td>After locating your vendor, &quot;Double Click&quot; on that vendor using your mouse.</td>
</tr>
<tr>
<td>13b</td>
<td>Clicking on the list button on either the &quot;Address Type&quot; or &quot;Sequence&quot; will provide a list of different addresses.</td>
</tr>
<tr>
<td>13c</td>
<td>Using the record bar below the entries, you can see the different addresses associated with that vendor.</td>
</tr>
<tr>
<td>13d</td>
<td>After locating your preferred address, &quot;Double Click&quot; on the &quot;Address Type&quot; using your mouse. This will update your &quot;Vendor Information&quot; fields.</td>
</tr>
</tbody>
</table>
**NOTE:** DO NOT add/adjust the "Discount" or "Currency" fields.**

**NOTE:** Upon arriving in this section, you will be assigned your purchase requisition number. Please write this number down as you will need it to attach your backup documentation.**

C. COMMODITY/ACCOUNTING SECTION

**NOTE:** Additional text information can also be added to the requisition itself by clicking on the "Related" tab in the top right menu bar and selecting "Document Text". On the next screen, hit the “Go” button at the right side. Multiple lines can be added (50 characters max per line) by using your mouse and clicking on the next field. Remember to save your document text to your requisition.

14 You can then tab down to the "Contact" or "Email" field to add additional contact information.

15 To move to the "Commodity/Account" Section, click on the "Next Section" icon or simply click on the tab using your mouse.

16 Add your backup documentation to your requisition at this time.

17 Tab to the "Description" field to enter the description of the first item to be purchased (50 character max).

18a If you are adding additional information for this line item, use your mouse and click on the "Related" tab in the top right of the menu bar and select "Item Text". On the next screen, hit the “Go” button at the right side. Multiple lines can be added (50 characters max per line) by using your mouse and clicking on the next field. Remember to save your item text to your requisition.

**NOTE:** Additional text information can also be added to the requisition itself by clicking on the "Related" tab in the top right menu bar and selecting "Document Text". On the next screen, hit the “Go” button at the right side. Multiple lines can be added (50 characters max per line) by using your mouse and clicking on the next field. Remember to save your document text to your requisition.

18b To navigate back to the Commodity/Accounting section, use your mouse and click on the "X" in the top menu.

19 If you are not adding additional text to the specific line item, tab to the U/M (Unit of Measure) field.

20 Use the list button to get a list of valid "U/M" codes.

21 Enter the "Quantity" of line item (1) you wish to order, then tab to the "Unit Price" field.

22 Enter the "Unit Price" of line item (1) you wish to order, then tab through the "Extended, Discount & Additional" fields to end up back at the "Description" field.

**NOTE:** DO NOT enter amounts into the "Discount" or "Additional" fields. Note the discount for the items in the "Item Text" field for that particular line item, then reflect the discount in the adjusted "Unit Price". **

23 Using your mouse, move your cursor to the next "Description" field and repeat steps 17 through 22 as necessary.

**NOTE:** If you run out of visible "Description" fields, you can use your mouse to click on the "Insert" tab in the menu bar to the right of the Commodity section. This will add another line for you to continue your entries. **

24 When you are finished adding commodity information, click on "Next Section" to move the accounting portion of this section.

25 COA (Chart of Accounts) is always "M".

26 Skip "Index" and enter your "Fund" and "Org" information into their respective fields. The "Prog" field will default populate. DO NOT change it.

27 Tab to the "Acct" field and enter **7300**. (This will be the Acct Code for all purchase requisitions).

28 Tab to the "Extended Amount" field and enter the amount you wish to be paid from this FOAPAL. You can pay from multiple FOAPAL’s but your "Document Accounting Total" must match your "Document Commodity Total".
**NOTE:** Requisitions paying from HEAF & Local Funds must be done on separate requisitions. Please note in the "Comments" field of the "Requestor/Delivery Information" section the corresponding REQ# for each requisition or "1 of 2". Backup documentation should be attached to both requisitions.**

**NOTE:** If you run out of visible "FOAPAL" fields you can use your mouse to click on the "Insert" tab in the menu bar to the right of the Accounting section. This will add another line for you to continue your entries.**

To move to the "Balancing/Completion" section, click on the "Next Section" icon or simply click on the tab using your mouse.

**BALANCING/COMPLETION SECTION**

You can use the "Next/Previous Section" function to navigate back to the "Requestor/Delivery Information" section and double check for errors. You can also use your mouse to click on each tab to navigate through your requisition.

If you need to save your requisition, you can click on the "In Process" icon at the bottom of this section. To reacquire your incomplete requisition, simply go to FPAREQ and enter your purchase requisition number.

If your requisition is complete and ready to move to the approval process, click on the "Complete" icon.

**NOTE:** If you need to retrieve a completed requisition, you can "Deny Document" in "FOADOCU". This must be done prior to the approval and forwarding of the requisition to the Purchasing Department.**

**NOTE:** To check on the status of a requisition, you can go to "FOAAINP" to see where your REQ is in the approval process.**

**ATTACHING BACKUP DOCUMENTATION**

1. Using your mouse click on the "Add" icon located in the top right of the screen.
2. Click on the “Add Page” button of the Application Extender window.
3. Click on the “Choose Files” button from the window that opens. Please convert ALL backup documents to PDF format.
4. Select the file that you wish to upload to the requisition and then click the “Open” button.

***PLEASE NOTE THAT DOCUMENT UPLOAD WILL BE EASIEST IF YOU PUT ALL OF THE PAGES IN THE SAME PDF FILE TO UPLOAD ALL AT ONCE. IF YOU SELECT MULTIPLE DOCUMENTS, THEY WILL ALL BE UPLOADED TO THE SAME DOCUMENT***

5. Once you have selected your document, click on the “Upload” button.
6. This will bring up your document. You will next need to click on the “Document Type” field.
7. Next, select “Requisition Backup” from the drop-down menu.
8. Then, click on the “Save” Button at the right side of the screen. This will upload ALL pages of the document you selected. If you have any other documents to upload, you will have to close this window and then go back through the same process to label and attach any other documents you wish to upload.
9. The Application Extender will show you the document you uploaded, including all pages of that document.